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Change your mouse cursor color

Change the cursor to any photo! Change your mouse cursor to anything you want! This chrome extension is open source (within the scope of the license, which can be viewed in the following repository); you can view the GitHub repository If the default mouse cursor size and cursor color are not to your liking, here's how
you can change them in Windows 10. The default Windows 10 mouse cursor is small and medium in size and white. For the vast majority of users, the default cursor size and color are good enough. However, you may want to change the cursor size or cursor color. For example, if you want your mouse pointer to be easy
on your eyes or have vision problems, changing the size and color of your cursor can help a lot. As part of accessibility features, Windows 10 Settings has the ability to adjust the size and color of your mouse pointer in just a few clicks. In this short guide, I'll show you the process of changing the mouse cursor size and
cursor color in Windows 10. Follow these steps to resize the cursor in Windows 10. Open the Settings app. Go to the Ease of Access page. Go to the Mouse pointer page. On the right, drag the slider under Resize Pointer To The Right to increase the size of the cursor. Changes are immediate and automatically saved.
Close the Settings app. You can use the slider to increase the size of the pointer up to 15 times. More often than not, the size of the indicator from 2 to 4 will be enough for most people. Play around with the cursor size slider and see how it works for you. Note that when you increase the size of the pointer, it will increase
all mouse pointer icons, such as viewfinder, motion, cursor, etc. To reduce the size of the cursor, drag the slider under Resize pointer to left. By dragging it all the way to the left, you can restore the cursor to its default size. As you can see, resizing the mouse pointer in Windows 10 is not difficult. If you want the cursor to
be larger, drag the slider to the right. To reduce it, drag the slider to the left. That's it. Follow these steps to change the cursor color in Windows 10. Press Windows Key + I to open the Settings app. Go to the Ease of Access page. Go to the Mouse pointer page. Select Custom in the Change indicator color section. Select
one of the available colors. To set a custom color, click Select Custom Pointer Color. Select a color from the color picker and click Ok. To restore the pointer to its original color, go to the Mouse pointer page in the Settings app and select White in the Change Pointer Color section. As you can see, Windows 10 makes it
quite easy to quickly increase or decrease the size of the mouse pointer and even its color. Play around a little and see which configuration suits you better. If you want, you can also increase the size of the system font and make the text easier before your eyes. I hope this helps. If you get stuck or need help, comment
below and try to help as much as possible. If you like this article, learn how to protect your system from ransomware and the best YouTube apps for Windows 10. 1 Open the Start menu on your computer. This button looks like the Windows icon in the lower left corner of the screen. The Start menu opens. 2 Click the gear
icon in the lower left corner. This is the Settings button in the lower left corner of the Start menu. Opens your computer settings in a new window. In some earlier versions of Windows, you can open Control Center from the Start menu, select Ease of Access here, and click Change Mouse Action. It gives you the same
options as here. 3 Click Accessibility in the Settings window. This opens accessibility options in the new menu. 4 Click the mouse to the left of the menu. On the left side of the Ease of Access menu there is a navigation menu. Select Mouse here to see your mouse and cursor options. 5 Select the size of the pointer that
you want to use under Pointer Size. Click one of the three options here to resize the cursor. Here you can select a small, medium, or large cursor. 6 Select the cursor color under Pointer Color. Just click the option you want to use under this heading to change the color of your cursor. You can choose: White indicator,
which will always be white. A black indicator that will always be black. An inversion indicator that automatically adjusts to the background color to make it look white on a darker background, and black on lighter backgrounds. 1 Open the Start menu on your computer. This button looks like the Windows icon in the lower
left corner of the screen. The Start menu opens. You can also click the search button or Cortana next to the Start menu icon. 2 Type the mouse on your keyboard. This will search the system and display the matching results in the menu. 3 Click Mouse Settings (Win 10) or Mouse at the top. Mouse settings should be the
best result in your search. 4 Click the additional mouse options (win 10 only) at the bottom. This is a blue link at the bottom of the Mouse Settings window in Windows 10. Opens the properties of the mouse. You can skip this step if you are using an older version of Windows. 5 Click the Pointers tab at the top of the
mouse properties. This button is next to Buttons at the top of the Mouse Properties window. 6 Click the drop-down menu below The Diagram. This opens all cursor options in the drop-down menu. 7 Select the set of cursors you want to use. You can select an option in the menu here to preview the entire set. 8 Check the
Enable pointer shadow box (optional). This option is located in the lower-left corner of the pop-up. When selected, the cursor will always have a small shadow under the cursor icon. 9 Click Apply. This button is located in the right corner of the pop-up window. It will apply for new settings and change the cursor to the
selected scheme. 1 Open the Apple menu in the menu bar. This button is located in the upper left corner of the screen. A drop-down menu opens. MacOS only allows you to resize the cursor; does not offer custom cursor patterns. However, you can download and use third-party cursor icons. 2 Click System Preferences
on the menu. This opens the Mac settings panel in a new window. 3 Click Accessibility in the system preference settings. This option looks like a white human icon in a blue circle. It can be found in the fourth row of options. In earlier versions of Mac, this option can be called Universal Access. 4 Click View on the left side
of the menu. On the Accessibility menu, locate and click View in the sidebar on the left. 5 Click and drag the cursor size slider. This slider allows you to manually adjust the size of the cursor to suit your needs. The new settings will be saved automatically. You can close system preferences after customization is
complete. 6 Select Shake mouse pointer to locate (optional). This option can be found below the Cursor Size slider. When this option is turned on, you can quickly shake the mouse to temporarily zoom in and easily find its location on the screen. 1 Open in a web browser. Type or paste this URL into your browser's
address bar, and then ⏎ Return to open the RW-Designer cursor gallery. It is an online, community-based cursor gallery. You can find and download many popular cursor icons here. Alternatively, you can check other websites and online galleries to find different cursor icons. 2 Click the cursor to see its details. When
you find the cursor pack you like, click it to view the package details on the new page. 3 Scroll down and click the cursor you want to download. You can download and use any cursor that ends with a .cur extension. Be sure to select the .cur cursor here. Animated cursor patterns in .neither format will work on your Mac. 4
Click the Download button. This downloads the selected cursor project to the Downloads folder. Now you will need to use a third-party application to apply this custom design to the cursor. You can use Mousecape, a small, free open source app, to use these custom cursor images on your Mac. You can check the
following methods to learn how. 1 Open . Type or paste this link into your browser's address bar, and then ⏎ Back to open the Mousecape page on GitHub. Mousecape is a free open source application for Mac OS computers to use custom cursor patterns. This link will open the latest version of Mousecape (0.0.6b2).
You can always check the page to see if a newer version appears. 2 Click Mousecape_0.0.6b2.zip under resources. You will find it at the bottom. This will download mousecape mousecape computer in a compressed ZIP file. 3 Open the Mousecape_0.0.6b2.zip file in the Downloads folder. This extracts mousecape to
your computer. 4 Double-click mousecape. After extracting the downloaded ZIP file, open Mousecape to use it on your Mac. 5 Click the File tab on the menu bar. When you open Mousecape, click the button in the menu bar in the upper-left corner of the screen. 6 Click New Cape on the File menu. This creates a new
Unnamed entry in the Mousecape window. 7 Right-click the new Unnamed entry in the tilt. This opens the right-click option. 8 Right-click Edit on the menu. This opens the properties of the new entry in the dialog box. This opens a new window to customize this new cursor linker. Be sure to check the following methods to
learn how to customize and use new cursors using Mousecape on mac. 1 Enter a name for the new cursor in the Name box. In the edit window, you can remove Unnamed in the Name box and give the custom name to the new cursor. 2 Click the + button in the lower left corner. This adds the Unknown cursor to this entry
in the menu on the left. 3 Click Unknown from the menu on the left. Here you can add a custom cursor design. 4 Click an item from the Type drop-down list. This opens a list of all types of cursors and functions that you can customize. 5 Select an arrow from the drop-down list. If you select this option, you can change the
design of the pointer cursor. 6 Drag and drop the downloaded .cur cursor design into the 1x box. Find the custom .cur cursor downloaded on your computer and drag it to the 1x box at the bottom of the Mousecape edit window. The new cursor design will now appear in the 1x box here. Optionally, you can change the
numbers in the Size field here and adjust the size of the custom cursor. 7 Click the red close button in the upper-left corner of the edit window. You'll be asked if you want to save your changes to a new project. 8 Click save in the pop-up window. This saves the new cursor design to mousecape. Now you can apply this
new cursor and start using it at any time. 1 Find the cursor you want to use in the Mousecape window. All custom ital italalic is saved and displayed here. When you create a custom cursor design, it is saved in the save. You can always go back and switch between different cursors at any time. 2 Right-click the cursor
entry in the Mousecape window. Right-click options appear in the drop-down menu. 3 Right-click the Apply button on the menu. This will immediately change the cursor to the selected project. 4 Click File on the menu bar. This opens a drop-down menu. 5 Click New Cape in the menu. This will create a unnamed entry in
the Mousecape window. 6 Right-click the new unnamed cursor entry. This opens the options in the right-click menu. 7 Right-click the Apply button on the menu. This will switch the cursor to your Mac's default design. You can also right-click here, and then select Delete to remove the selected project from your computer.
Add a new question Question I could not find the cursor folder. Any ideas? Click Windows Start, and then click Run. Type Windows, and then click enter and you'll be in the Windows folder. The cursor folder should be somewhere there. Question I changed the cursor with Custom Crust and now I can not recover it. How
do I set the cursor back to the default? In Mousecape, make a new cape without a picture. Use this and don't change it. Question When I click, why does the cursor go away? Make sure you right-click the cape and press the Apply button. It should work. Ask a question thanks! This article was co-authored by our trained
team of editors and researchers who confirmed it for accuracy and complexity. wikiHow's Content Management Team closely monitors the work of our editorial staff to ensure that each article is supported by trusted research and meets our high quality standards. This article has been viewed 115,828 times. Contributors:
24 Updated: July 7, 2020 Views: 115,828 Categories: Print Displays Send a message to authors Thank you to all authors for creating a page that has been read 115,828 times. Times.
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